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INTRODUCTION 
 

This is a brief introduction to the most central parts of Corema. Because several parts of 

Corema are not mentioned at all, or only briefly, anyone intending to use the program should 

also have a look at the Corema Help section (menu Help>Contents...). In fact, that 

should be done even if you just intend to use the parts treated in this introduction. 

 

NB! For additions and changes made in versions after the one this manual refers to (see front 

page), please refer to the Corema Version history for an overview of these. 

Some Corema basics 
 The basic unit in Corema is the individual specimen, which is registered as an 

accession. Several samples from the same individual and sampling event should be 

registered as items belonging to the same accession (see below for more details about 

different types of item) 

 Thus, several samples taken from e.g. a bird during one sampling event should be 

registered as different items under one accession 

 If, on the other hand, the bird is recaptured later the same day/season/etc., samples 

taken during this sampling event should be registered as items under a new accession. 

Individual id, or some other individual specific ID field, should in such cases be 

identical so that all accessions of an individual can be identified 

 In botany, “population samples” of e.g. 10 individuals of the supposedly same taxon 

from a restricted, small area would typically be registered as 10 accessions, each with 

one e.g. tissue item, sharing the same Pop. no but with different Pop. spec. no 

 Further, when e.g. DNA is extracted from a tissue or blood sample, this should be 

registered as a new DNA extract item under the same accession as where the 

tissue/blood sample is registered. The relationship to a specific item may also be 

recorded in the Item ref. field (may be useful if e.g. several tissue and/or blood items 

exist) 

 There is no limit to the number of items that can be registered on an accession, and it 

is also possible to register several items of the same type on one accession 

 In File>Options some global settings for the program interface can be set; 

o Confirm unsaved: Choose True to get a warning if you try to leave a form with 

unsaved data in it (recommended) 

o Language: Choose interface language (so far only English [en] is available) 

o Large toolbar: Choose True to increase the size of the toolbar buttons 

o Image max resolution: Images can either be saved in original size (Original; 

not recommended due to storage space requirements), or reduced to a smaller 

or larger extent upon saving in Corema (MegaPix_1-MegaPix_5) 

o Long location code: Choose False to avoid unnecessarily long location codes 

(the full code will still be visible in drop-down lists) 

 On-screen field names: All field names appear to the left of the actual fields, in the 

same order as the fields themselves. Field names starting with lowercase letters should 

be read as having the first word in common with the first field on the same line (e.g. 

the field names Det. date, person and level should be understood as fields Det. date, 

Det. person and Det. level). 

 Numbers in curly brackets (e.g. {1}) in the text refer to numbers on figures within the 

same sections of the text. 
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PROGRAM INTERFACE 
 

 

 
 

 

1 Navigation bar Provides access to all the different forms (modules), such as 

Accessions, Taxa, etc. 

2 Menus & tool bar Commands related to the current form. Also shows the current 

collection to the far left 

3 Status bar Messages and other information 

4 Main area Viewing and entering of data 

5 Express search fields Quick searching for accession numbers, barcodes containing 

either accession numbers or UUIDs, taxon or family names and 

locality information 

2 

5 

4 

3 

1 
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COLLECTIONS 
Corema exists in to “versions” at NHM; Corema-Bot and Corema-Zoo, for the botanical and 

zoological DNA bank collections, respectively. Further, each of these contain several 

collections, corresponding roughly to major taxonomic groups within their fields. These are: 

 

Version Collection Collection acronym 

Botany DNA Plant Collection O-DP 

 DNA Moss Collection  O-DM 

 DNA Fungi & Lichens Collection O-DFL 

Zoology Bird Collection (also “non-DNA” collections; 

sperm, eggs, skins etc.) 

NHMO-BI 

 DNA Fish & Herptile Collection  NHMO-DFH 

 DNA Mammal Collection NHMO-DMA 

 DNA Arthropod Collection NHMO-DAR 

 DNA Other groups Collection NHMO-DOT 

 

Accession is given to each of these collections individually, meaning that any user may have 

access to one or more collection(s). Further, there are several levels of access; most users will 

start with Reader access, to allow them getting used to the program and “play around” 

without having to worry about deleting data or otherwise “messing anything up”. 

 

With Reader access you can read all available data, but editing is possible only in the Tasks 

form, including creating new tasks. This has been made so because tasks are such a useful 

way to work with data in Corema, and may be most useful even to users without any further 

editing access. Have a look in the Tasks section below and try it out! 

 

Whenever you feel comfortable with the software and have a need for a higher access level, 

typically allowing entering new and changing existing data, just contact the Corema 

administrator to have your authorization upgraded. 

 

mailto:l.e.johannessen@nhm.uio.no?subject=Data%20for%20import%20to%20Corema
mailto:l.e.johannessen@nhm.uio.no?subject=Data%20for%20import%20to%20Corema
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ITEM TYPES 
A number of different item types are available in Corema, some of which are derived from 

other item types. Which item types are available differs among the collections. Below is a 

brief description of these, including whether they are derived and which collections they are 

available in. 

 

  NHMO  O 

Item type Description B
I 

D
F

H
 

D
M

A
 

D
A

R
 

D
O

T
 

 D
P

 

D
M

 

D
F

L
 

Tissue Tissue sample stored for genetic 

analyses 

X X X X X  X X X 

DNA extract Extracted DNA [derived] X X X X X  X X X 

Preserved specimen Preserved study specimen, e.g. 

study skin, mounted specimen, 

herbarium sheet etc. 

X X X X X  X X X 

Blood Blood sample stored for genetic 

analyses 

X         

Feather Preserved feather X         

Sperm Sperm sample stored for 

morphological analyses 

X         

Sperm slide Microscope slide prepared for 

sperm morphological analyses 

[derived] 

X         

Sperm recording Footage of live sperm swimming 

behaviour 

X         

Testes Testes stored for further analyses X         

Seminal glomera Seminal glomera stored for 

further analyses 

X         

Egg Complete clutches or single 

emptied eggshells 

X         

Living Living specimens, typically kept 

in the phytothron 

      X X X 

Seeds Seed samples stored for further 

propagation or analyses 

      X   
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SEARCH 
There are three ways to search for data in Corema; 

 Enter search criteria in the yellow Express search fields at the top of the form 

 Enter search criteria directly in the relevant fields of any given form (Regular search), 

or 

 Use the Advanced search criteria 

 

If a search returns more than one match, the result will be presented in a search result list. To 

select an item in the list, double click or highlight the item and press the space bar. If only one 

match is found, the item will be presented directly in the relevant form. 

 

In forms where the search may return a large result set, a Max search value for limiting the 

number of returned results is shown in the tool bar. The default value for this is 5000. If your 

search returns more than 5000 accessions, only the first 5000 will be shown and the 

background colour of Max search will change to yellow to inform you that not all matches are 

shown. In this case, preferably constrain your search by adding more/stricter search criteria, 

or alternatively choose a higher value for Max search. The unlimited option (∞) should be 

used with care, as this may result in slow searches. 

 

Express search 
The Express search fields are the yellow fields at the top of the Accessions and Taxa forms 

that has a circle (˚) or a tilde (˜) at the end of the field name, viz. Accession number, Taxon 
name and Family. These can be used to perform quick searches for these data types. 

The Taxon field has the special function that if you write the first letter(s) of the genus and 

species names, separated by a space, you will get all accessions or taxa with Genus and 

Species beginning with the given letters. 

 

Regular search 
You may search for accessions by entering search criteria in one or more of the searchable 

fields of any form. Searchable fields are indicated by either a small circle (˚) or a tilde (˜) 

following the field name. For fields marked with a circle (˚) exact matches are used, while 

fields with a tilde (˜) uses like matches. In fields with a tilde (˜) it is, however, also possible to 

use exact match, by ending the selection criterion with “||” (two “pipes”; |).  

 

Wildcard searches are also supported; the wildcard character is “%”. 

 

To perform a search: 

1. Navigate to the relevant form, click  (Clear/New; Ctrl+E) and fill in your search 

criteria in one or more fields 

2. Execute the search; 

o Click  (Search; Ctrl+F) to show a list of accessions matching the search 

criteria 

o Click on the arrow at the right of the same button ( ) and choose Search 

Items (Ctrl+I) to show a list of items matching the search criteria 
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Advanced search 
A more advanced search is also available; click  (Adv. search; Ctrl+S) to access this. 

This is advanced in several respects; 

 There are more search fields available 

 Several types of searches can be selected for most fields 

 Search criteria will remain in the search fields and searches may thus easily be refined 

 

To use the Advanced search: 

1. Navigate to the relevant form, click  (Clear/New; Ctrl+E) and then click  (Adv. 
search; Ctrl+S) 

2. Tick off the search field(s) you want to use 

3. Select type of search from the first drop-down menu 

4. Enter your search criteria, or choose these from the drop-down menu if available 

5. Repeat this for all fields you want to include in the search (all ticked-off criteria will 

be combined in the search) 

6. Execute the search; 

o Click  (Search; Ctrl+F) to show a list of accessions matching the search 

criteria 

o Click on the arrow at the right of the same button ( ) and choose Search 

Items (Ctrl+I) to show a list of items matching the search criteria 
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TASKS 
Tasks is a very powerful and useful function in Corema, and is used to create “bundles” of 

e.g. accessions, items or taxa in the collection. Tasks can then be used as a simple search 

criterion in the Accessions, Taxa and Item management forms, and as a selection criterion 

for Reports and Maps. As mentioned above, tasks can be created and edited also by users 

with only Reader access. 

 

A task can consist of accessions, items or taxa (and actually more; see Corema Help for more 

info), but any one task can only contain entries of one type. 

 

Whenever you will be working with the same selection of e.g. accessions or items more than 

once, it will probably save you time to store these in a task. You would then have do the job 

of searching out all relevant accessions or items during the making of the task, but whenever 

you need to retrieve the same accessions or items later on, you just have to enter one search 

criteria, viz. the task number. And accessions, items or taxa can also be added or removed 

from a task at a later stage. 

 

You may also add comments to each entry of a task, as well as label them as Open, 

Completed or Excluded. Both comments and labels will only be stored within the task, and 

will thus not influence the “original” accessions. 

 

All tasks will by default be assigned to the user currently logged in, but this may be changed 

as desired. All Corema users can, however, access all tasks, irrespective of who created or 

owns them. Feel free to use other’s tasks, if useful, but please do not change them without 

consulting the owner! 

 

To show all existing tasks, go to the Tasks form, click  (Clear/New; Ctrl+E) to clear the 

form if necessary, and then hit Ctrl+F. 

 

To register a task: 

1. Go to the Tasks form, under the Events heading in the Navigation pane 

2. If necessary, click  (Clear/New; Ctrl+E) to clear the form 

3. Fill in a meaningful and descriptive name for the task in Name – this should be 

meaningful also to other users! 

4. Choose a Type for the task, depending on whether it is intended just for temporary use 

(Temporary) or to be permanent (Permanent) 

o Permanent tasks will never be deleted, e.g. masters project or samples used in a 

scientific paper 

o Temporary tasks can be deleted by the administrator after 6 months, or when 

they are marked with Status = Closed 

5. You may also add more info about the task, especially if it is a permanent one, in 

Description and/or Comments 

6. The following fields will be filled in automatically upon save; 

o No (next vacant number) – this is the number you should use to search for a 

task 

o Status (Open) 

o Date (current date) 

o Priority (0: none; may be changed as desirable) 

o Owner (currently logged in user name) 

o Reg. init. (currently logged in user initials [user name]) 

o Reg. date (current date) 
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7. Choose what kind of objects are to be stored in the task from the drop-down menu in 

Entries kind 

8. Finally, add the actual objects in the area indicated on the figure below, by either of 

these methods; 

o Type the accession number in Code/Name and press the Enter key to validate 

it; if it is valid the accession will be added to the task 

o Click  in Code/Name to open the Accessions form, from which you can 

search for records as described in the Search section above. When you have 

selected one or more records to be included in the task, press 

 to copy the records back to the Event form  

o Paste one or multiple newline-delimited values (e.g. from an Excel 

spreadsheet) into Code/Name. The entered accession numbers will then be 

validated and any invalid numbers indicated by empty lines and a red/white X 

symbol . Any invalid lines will have to be deleted before the task can be 

saved 

9. When all objects have been added to the task, the task has to be saved by clicking the 

Save button in upper right corner 

 

All objects associated with a task will be listed in the lower part of the Tasks form {1}, with 

accession number (and species and location, depending on type of objects) and any comments 

and status entered. To get more details for the objects, there are two options: 

 Select one object (line) and click  to go to the relevant form for that entry 

 Create a report (e.g. Items - Most often used data) for all objects in the task by entering 

the task number in the Event name selection criteria field 

Similarly, the task number can be used as search/selection criterion to search for accessions, 

create maps etc. 

 

 
 

1 
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REPORTS 
To get data out from Corema, use any of the pre-defined reports found in the Reports form. 

 

The reports are arranged in sections according to their main focus; generally, they are listed so 

that the first ones in any one section are the more relevant to most users. When a report is 

selected, some more details about what it will contain is presented in the upper right panel 

(above the search fields). Here is a brief explanation of the various groups of reports: 

 

Report section Report contents 

Accession objects Accession level data: taxonomy, locality, collection event, 

images, restrictions, … 

Accession items Item level data: same as previous plus item level data such as 

item types, item details (e.g. extraction data), storage 

location etc. 

Taxa Taxon-specific data, and counts per taxa, including images 

for taxa 

Events Data for tasks, including data for the elements stored in the 

task (accessions, items etc.) 

Management Data for contacts, labels with contact data, library items and 

storage locations 

Statistics Various statistical reports; counts of collections, accessions, 

items etc. Mostly relevant only for collection administrators 

Miscellaneous DarwinCore exports, code list contents and locality data 

 

 

To create a report: 

 

1. Select a report in the list 

2. Fill in the desired selection criteria. Only criteria selected by ticking off the checkbox 

next to it will be used. Empty criteria (even if selected) will be ignored. 

3. Indicate sorting order (ascending/descending) and sequence by choosing 1 for the first 

sorting variable, 2 for the next and so on. If left unchanged (i.e. = 0) the data will not 

be sorted by that variable. 

4. Depending on report type, one or more of the buttons View, Print and Export will be 

available in the upper right corner; use either of these to produce the report; 

o View: Open the report for viewing (most reports will produce an MS Excel file 

and thus be opened in this program). If a large number of accessions are 

included in the report, the viewing of the report might fail. In that case, using 

the Export button to create a text file (*.txt) which may be opened from within 

MS Excel may help 

o Print: Print a hard copy of the report. Specify printer in the appearing dialog 

box 

o Export: Save the report to a file; 

 In the appearing dialog box the location as well as the format of the file 

may be specified; available file formats will vary depending on report 

type 

 If you choose to save to an already existing file, a dialog box gives you 

the choice of appending the current data set to the file (default) or to 

overwrite the file (i.e. replace all data in the file with the current data 

set) 
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MAPS 
Maps can be plotted for accessions and localities, provided that these have valid coordinates 

registered;  

 Accessions map will produce a map with separate points for each accession, with 

certain accession details available as labels for the map points, and more details 

available by clicking on the labels and in a file which may be saved together with the 

map image (see below) 

 Localities map will produce a map with separate points for each locality, with certain 

locality details available as labels for the map points, and more details available by 

clicking on the labels and in a file which may be saved together with the map image 

 

A number of base maps are available, including e.g. various Google, Bing and Yahoo maps as 

well as “Norgeskart” from the Norwegian Mapping Authority. These can be selected after the 

map has been plotted. Further, the appearance of the map points can be altered by the user 

(however, only for all plots in a map simultaneously). 

 

How much info to display in the point labels, and whether they should be permanent or just 

show up when hovering over the point, can also be selected by the user. 

 

Clicking on a map point in an Accessions map brings up either the Accessions form (if only 

one) or a result list (if several) for all accessions associated with that map point. If more than 

one accession is associated with a map point, this will be indicated by e.g. “+ 14 additional” 

in the label. Similarly, for a Localities map, the Localities form is brought up. 

 

The maps can be printed or saved to files (image file and Excel file with accompanying data), 

and finally your favourite selection of map type, markers etc. can be stored as defaults for 

new maps. 

 

Explanations of the controls available in the map window are provided in the figure on next 

page. For further details about maps, see the Maps section in the Corema Help. 

 

NB1! Remember that only accessions/localities with valid coordinates will be shown in a 

map, meaning that Corema has been able to convert the originally entered coordinates to 

latitude and longitude (see below for more on this). There may be more accessions/localities 

matching the selection criteria but lacking valid coordinates, and the map may therefore not 

provide a good impression of the true distribution of the accessions/localities intended to be 

plotted! 

 

NB2! To show maps an internet connection is required. 
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Map examples 
Below is an example of the same accessions plotted with the two different map types. 

 

Accessions map Localities map 

   
 

Map controls & customizing 
 

 

 
 

 

 

 

1. Background map type 

2. Marker shape & colour 

3. Zoom to include all markers in the map at maximum zoom 

4. Swap between colour and grayscale map 

5. Add labels to markers 

 Permanent or dynamic (i.e., showing only when pointing to a marker) 

 Various levels of details 

6. Reposition labels 

 If there are many markers and labels on the map, some will often be hidden 

behind others; use this button to try various repositions of the labels 

7. Print map 

8. Export map 

9. Set map defaults 

10. Clear map cache 

 

2 1 

3 5 7 9 

4 6 8 
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WHERE TO FIND THE DATA YOU’RE LOOKING FOR 
Although most Corema data fields hopefully are informatively named, it may still sometimes 

be hard to guess in which field the data you are looking for is stored. 

 

Below is a brief guide to where the most common data are located, along with hints about 

some of the perhaps less logical field names (in this font). 
 

Accessions – Details 

 
 

1. Taxonomy 

2. Locality 

3. Collection data 

 Collector, collection date, field/sample ID (Coll. no), Pop. no, ring number 

(Individual id) 

4. Samples originating from other collections (NHM or other museums) 

 Voucher collection, voucher ID (Origin ref.) 
5. Various sample info 

 Age (Life stage), sex, restrictions (on whole accession) 

6. Various “custom attributes” 

 Biometry, additional IDs (Ind. no., Nest no., …), BOLD/GenBank info, 

culture, host,… 

7. Determination history 

8. Express search fields 

2 

7 

6 

5 

4 

3 

1 

Sample/field number (Coll. no) 

 

 

Pop No 

Ring number (IndividualId) 

Voucher number other 

collection (Origin ref.) 
 

Sex 

 

Age (Life stage) 
Restrictions (on whole accession) 

8 
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Accessions – Items 

 
 

1. Registered items 

2. Item type 

3. Storage location for items 

4. Item status 

5. Item details 

 Sample type, storage container, storage medium, extraction method, … 

 

 

3 

5 

1 

Old database/journal number 

(Cons. no.) 
 

 

Restrictions (only single item) 

4 2 
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Accessions – Images 

 
 

1. Available images linked to accession 

2. Image details 

3. Preview of selected image 

4. Buttons for Copy, Save etc. 

 

 

2 

3 1 

4 
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Accessions – References 

 
 

1. References, permits, data sets etc. linked to the accession (or single item; if so this is 

indicated in the Item column) 

2. Tasks, loans or exchanges in which the accession is involved 

2 

1 

Buttons to access more details 

in the Library and Events 

forms, respectively 

Button to open linked 

documents (e.g. PDFs, 

Excel files etc.) directly 
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ENTERING NEW ACCESSIONS 
New accessions can of course be entered directly in Corema, although for larger data sets it 

will probably be more efficient to import the data via Excel template files. Below both 

alternatives are described, focusing on the most common and important fields for the former. 

Entering data in Corema 
To start entering data for a new accession, go to the Accessions form and, if necessary, click 

 (Clear/New; Ctrl+E) to clear the form. Then fill in as much information as you can for the 

accession and associated items; main pieces of info are mentioned below, with those most 

important and/or most often used in bold face: 

 

1. Determination (taxon)  

2. Locality 

3. Collection data 

4. Origin; for samples obtained from other collections (also within NHMO), museums or 

similar 

5. Sex & age 

6. Restrictions 

7. Biometry etc. 

8. Permits etc.  

9. Images 

10. Parentage 

11. Items 

2 

8 

7 

5 

4 

3 

1 

9 11 

6 

10 
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Determination (taxon identity) 

 

1. Start typing the taxon name in Taxon name {1}; if the taxon is already registered in 

Corema, it will show up in the list and you can select it 

2. If the taxon cannot be found in the list, it will have to be added to the taxon registry. 

Feel free to contact the Corema administrator to get help with this, or continue to add 

it yourself as follows: 

a) Click on  in Taxon name to go to the Taxa form 

b) First search for all registered species in the relevant genus by entering the 

genus name in Genus and search (Ctrl+F) 

c) Check to see if the desired taxon indeed is on the resulting list – perhaps only a 

typo or slightly different way of spelling prevented it from popping up in the 

taxon list? 

 If you do find the correct taxon, select it and click  to 

copy the taxon back to the Accessions form 

 If not, continue below 

d) Clear the Taxa form by clicking  (Clear/New; Ctrl+E) 

e) Choose genus from the Genus field 

 If you cannot find the genus in the Genus list, contact the Corema 

administrator to have it registered 

f) Enter the new species name in Species and species author in Species Author 
(and similar for subspecies in Infra name and Infra Author, if relevant) 

g) Select a source for the new taxon (preferably one of those available in the drop-

down menu). Any new species added should be based on some authoritative 

source, like the IOC Bird list for birds, Fauna Europaea for most of the 

arthropods, Mammal Species of the World for mammals etc. 

h) Click Save and then  to copy the taxon back to the 

Accessions form 

3. Other relevant fields in the Determination and Properties panels: 

 Uncertain species identity may be indicated in Det. type {2} at the lower right 

of the Properties panel 

 If the species identity has been confirmed by genetic analyses, by a specialist 

or similar, this can be indicated in Det. level {3} 

 Det. date and Det. person will default to the same as Coll. date and Collector, 
respectively (see below) 

2 

3 

1 

mailto:l.e.johannessen@nhm.uio.no?subject=Data%20for%20import%20to%20Corema
mailto:l.e.johannessen@nhm.uio.no?subject=Data%20for%20import%20to%20Corema
mailto:l.e.johannessen@nhm.uio.no?subject=Data%20for%20import%20to%20Corema
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Locality 

 

1. Click  in Locality {1} to go to the Localities form 

2. First check to see if the locality is already registered, by filling in Country etc. and 

performing a search (Ctrl+F) 

 If you find the locality, select it and click  to copy the 

locality back to the Accessions form 

 If not, continue below 

3. Fill in as many as possible of the fields Country, Ocean, Subdiv. 1 (i.e., county), 

Subdiv. 2 (i.e., municipality), Locality, Alt. from (altitude, or lower bound of altitude 

range), Alt. to (only to be used for upper bound of altitude range), Alt. unit (defaults to 

meters), Org. coord (coordinates) and Datum. 

4. If the coordinates given do not refer to an exact locality, but e.g. a larger sampling 

area, an island or similar, indicate the radius of a circle in which the true sampling 

localities are located in Trueness. Precision is to be used for coordinate uncertainty, 

e.g. as indicated on a GPS device (e.g. +/- 5 m). 

5. Some comments on coordinates: 

 There are two Org. coord. fields; latitudes should be entered in the first and 

longitude in the second of these. Remember to include N or S and E or W, 

respectively, at the end 

 UTM coordinates should be entered in the first of the two Org. coord. fields 

only, and has to be on the format ZoneNumberZoneLetter Easting Northing, 

i.e. the parts have to be separated by a space and this is thus the only valid 

format: 

▫ 32V 598995 6643642 

 MGRS coordinates should also be entered in the first of the two Org. coord. 
fields only, and on the format ZoneNumber ZoneLetter Square Easting 

Northing. Spaces may or may not be included. Easting and northing can be 

indicated with 1-5 digits each (but they have to have the same number of 

digits), reflecting the precision of the coordinates; 1 digit = 10.000 m, 5 digits 

= 1 m precision. All of these (and more) are therefore valid: 

▫ 32VNM9899543642 

▫ 32 V NM 98995 43642 

▫ 32 V NM 98995 43642 

▫ 32V NM 990 436 

 Provided that the original coordinates are entered according to the 

specifications, they will be converted to decimal degrees in the Dec. deg. lat. 

and Dec. deg. long. fields when the locality is saved. After this, click  to 

verify that the locality is indeed plotted where you expected it to be. If not, 

please correct the errors before proceeding. 

6. When all data have been filled in, click Save and then  to copy the 

locality back to the Accessions form 

7. Other relevant fields in the Location panel: 

 {2} Habitat (ecology etc.), Aspect (direction [N, S, etc.] in which the locality 

faces) and Slope (terrain steepness) 

2 

3 
1 
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 Project {3}; if the accession is part of a larger project, the project can be 

registered in the Projects form and then selected in this field 

Collection data 

 

Enter any relevant collection information in the corresponding fields in the Collection section. 

 {1} Collector and Coll. date should always be filled in 

 {2} Pop. no. and spec. no should be filled in for botanical population samples. Pop. 
no. has to be unique, i.e. not used in Corema before! 

 Individual id {3} should be filled in if the sample is from a uniquely marked 

individual (e.g. banded birds or tagged fish). Any number or code entered in this 

field should be unique within the current Corema collection! 

 Coll. no {4} can be used e.g. for field sample numbers or other “semi unique” 

identifiers 

Origin 

 

For samples originating from other NHMO collections, other museums, collections etc., 

register the institution, person etc. of origin as well as any reference or ID number for the 

specimen in that collection: 

1. Click  in Contact {1} to go to the Contacts form 

2. First check to see if the contact is already registered by showing all contacts (Ctrl+F) 

 If you find the contact, select it and click  to copy the 

contact back to the Accessions form (all registered NHMO collections start 

with “NHMO…”) 

 If not, continue below 

3. Fill in as much info as possible about the contact, including at least the following: 

Name, Country and preferably some contact info (Phone, E-mail, Web site). Code, Id 

and Status will be filled in automatically. 

4. Do also add a Role by clicking  in the Roles panel and selecting one of the available 

roles 

5. When all data have been filled in, click Save and then  to copy the 

contact back to the Accessions form 

6. Finally, in Origin ref. {2}, register any accession, registration or other ID number 

associated with the sample(s) in the collection of origin 

1 

2 
3 

4 
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Sex & age 

 

Information on sex and age should be entered in the Material section, in Sex {1} and Life 
stage {2}, respectively. Material Type {3} in this section should only be used if e.g. a DNA 

extract or some other derived item type is received and the source from which this is derived 

therefore cannot be registered as a separate item. In this case, choose source type from the 

Material drop-down menu. However, as far as possible, both the source and derived objects 

should be registered as separate items of the relevant type, and the derived item should be 

linked to the source item by use of the Item ref. field for items (see below). 

Restrictions 

 

The default assumption for all material entering the NHMO DNA bank is that there are no 

restrictions on the publication or use of the samples, as long as this is in accordance with the 

DNA bank grant policy and MTA (see DNA bank website for more details). It is, however, 

possible to place restrictions of various kinds on accessions, items and taxa, but this will then 

have to be cleared with the DNA bank before doing so. 

An overview of the various restriction types can be found in the Restriction types form under 

the Definitions heading in the Navigation pane. There are three levels of restrictions (None, 

Limited and Prohibited), and these can be set independently for publication and usage of the 

accessions, items or taxa to which the restriction type is applied. Further, restrictions are 

hierarchical so that taxon restrictions override accession restrictions, and accession 

restrictions override item restrictions. 

For changes in taxon restrictions contact the Corema administrator. Restrictions on samples 

should normally be registered on the accession level, i.e. in Restrictions {1} at the bottom of 

the Details tab. This is because any restrictions usually will apply to all items of an accession. 

For restrictions applying only to some but not all items of an accession, see below. 

Biometry etc. 

 
 

A range of additional fields are available for various other pieces of information not included 

among the main fields in Corema; these appear in the Attributes panel at the right side of the 

Accessions form. To see the full list of available attributes (different for zoology and botany) 

and what type of data they accept (unit, if applicable, is included as part of the attribute 

1 2 

3 

1 2 

1 

http://www.nhm.uio.no/english/research/infrastructure/dna-bank/
mailto:l.e.johannessen@nhm.uio.no?subject=Data%20for%20import%20to%20Corema


COREMA – A BRIEF INTRODUCTION 

23 

 

name), go to Custom attributes in the Definitions part of the Navigation bar. Below some of 

the custom attributes are mentioned: 

 Zoology: Several biometric measurements; Colour codes or other additional individual 

identifiers; Nest ID, BOLD info; GenBank accession number, Host info; Hatching info 

(species and stadium hatched from); Culture info for cultured individuals. 

 Botany: Ploidy level; Host species; BOLD info, GenBank accession number 

 

To add data in a custom attribute field: 

1. Click  in the Attributes panel and select which attributes to add data for in the drop-

down menu of the blank field becoming available {1} 

2. Fill in the relevant value or information in the Value field {2) for that attribute 

Permits etc. 

 

Any permits or other documentation relating to the sample should be properly registered 

before the sample itself is entered into any collection. It is also highly desirable to have all 

relevant documentation registered in Corema, to facilitate subsequent use of the samples. 

It is advisable to register PDFs of all collection, export, import, CITES etc. permits, as well as 

any other relevant documents (PIC, MAT, MTA) in the Library form in Corema, and then link 

these to all related accessions. 

 

To add documentation: 

1. Go to the References tab and click  in the Library items panel 

2. If the documentation is already registered, this can be selected from the drop-down 

menu in Author(s) 

3. If not, click  in Author(s) to go to the Library form 

4. Fill in enough relevant info to enable yourself and others to recognize the document on 

a later occasion. For permits etc. this should at least include the fields Author (e.g. 

issuing agency), Year, Title and Type. 

5. Add the PDF by clicking  in E-Document, selecting the PDF file and clicking Open 

6. Click Save and then  to copy the documentation back to the 

Accessions form 

 

You can add as many documents as you like for each accession.  
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Images 

 

Images can be added in the Images tab. Just drag and drop image files from Windows 

Explorer into the large open field at the left side of the form {1}, or add them by clicking  

at the top left of the form and navigate to the file(s). 

If available, some info for the image info fields at the lower left will be taken from EXIF info 

in the image files during import, but you may also add or change this info yourself after 

having imported the images. 

Parentage 

 

Parent-offspring relations among accessions (e.g. tissue samples from parents and offspring) 

can also be recorded, in the Parentage tab: 

1. Register the parent accession(s) as normally 

2. Register the offspring accession  

3. In the Parentage tab, use the  button in Parent-1 (mother) and Parent-2 (father) {1} 

to search for and add the parent accessions. Remember to click the  

after having found the right accessions to copy them back to the Accessions form. 

4. Sex ({2}; conventionally Parent-1 should be the mother) and whether the parentage is 

considered certain (certain {3}) can then be filled in 

1 

1 2 3 
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In the parent individual accessions all registered offspring will then be listed in the Progeny 

panel in the Parentage tab {4}. 

Items 

 

Finally, do not forget to register the actual items! This is done in the Items tab, starting in the 

Items panel on the left side of the form {1}: 

1. Select item type in Type {2} 

2. Specify a storage location for the item in Location {3}. This has to be chosen from the 

list of available locations, which typically refers to racks in specific freezers, shelfs in 

cabinets etc. By sorting on the Code long column the available locations will be sorted 

by room number, freezer/cabinet and rack/shelf. If you do not know the location at the 

time of registration, or you will hand the items over to the DNA bank curator for 

further storage, choose Code short = “?” in this field, as it cannot be left empty. 

3. Further sublocations can be entered in Location. ref. {4} or Location subref. {5}. 

These can be e.g. box number within a rack or shelf (Loc. ref.), recording number 

within a video (Loc. ref.), well number within a plate or tube number within a box 

(Loc. subref.), or start and stop times within a video recording (Loc. subref.). 
4. Specify a status for the item in Status {6}. Hopefully this will be “OK” as long as the 

item is not already used up, damaged or similar 

5. Depending on type of item, several other fields, especially in the Material section of 

the right panel {7}, should also be filled in, including Prep. type (item subtype, or 

extraction protocol for DNA extracts), Storage container, Storage medium, Created 
date and Created person. 

6. Restrictions should in most cases be registered for the accession in general (i.e. in the 

Restrictions field in the Details tab; see above), as they normally will apply to all 

items of an accession. However, any restrictions applying only to specific items 

should be registered in Restrictions {8} in the Items tab. 

1 4/5 

4 3 2 6 

7 

8 



COREMA – A BRIEF INTRODUCTION 

26 

 

Import of data 
To register larger chunks of samples it will probably be most efficient to use the MS Excel 

template sheets available for several of the collections. In these data can easily be copied from 

existing field note or other files, and registration of collection dates or other repetitive data 

can be done very quick and efficiently. After having filled in the import file, send it to the 

Corema administrator to have it validated and imported into Corema. 

 

Before you start to fill in your data, be sure to download the latest version of the import 

template file from the DNA Bank section of the NHM best Practice Wiki. These files are 

constantly changed, and using the old version you have stored on your local hard drive – even 

if it’s just a few days old! – can cause a lot of extra work during import! 

 

Do also take the time to read the information in the Info tab of the file – it will probably both 

save you time when filling in the file, and increase the chances that the file can be easily 

imported to Corema . 

mailto:l.e.johannessen@nhm.uio.no?subject=Data%20for%20import%20to%20Corema
https://wiki.uio.no/nhm/skf/best-practices/index.php/DNA_Bank

